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Apparence de LibreOffice

LibreOffice fonctionne sous les systèmes d’exploitation Windows, Linux et Mac OS X, chacun de
ces systèmes pouvant exister sous plusieurs versions. Chacune de ces configurations peut donner
lieu  à  des options  d’affichage différentes  (polices,  couleurs,  thèmes,  gestionnaire  de fenêtres,
icônes). De plus, ces options d’affichage sont pour certaines personnalisables par les utilisateurs.

Les illustrations  de ce chapitre ont  été réalisées sous Windows avec le  jeu  d’icônes  Galaxy.
Certaines  images  ne  ressembleront  donc  pas  exactement  à  ce  que  vous  voyez  sur  votre
ordinateur. En cas de confusion sur une icône, dont l’apparence peut être très différente d’un jeu à
l’autre, vous pouvez vérifier son nom, qui apparaît dans l’infobulle lorsque vous placez le pointeur
de  la  souris  au-dessus.  Pour  modifier  le  style  des  icônes,  sélectionnez  Outils  >  Options  >
LibreOffice > Affichage et dans la section Interface utilisateur choisissez la taille et le style des
icônes.

Introduction

Dans les diapositives, tous les textes sont contenus dans des Cadres de texte. Ce chapitre décrit
comment créer, modifier, utiliser et supprimer des Cadres de texte. Il présente aussi les différents
types de texte d’Impress et montre comment les formater. Enfin, il détaille comment insérer des
formes spéciales de texte telles que tableaux, listes numérotées ou listes à puces, champs et
hyperliens.

Travailler avec les cadres de texte

Il y a deux manières d’ajouter des cadres de texte aux diapositives.

• Dans la section Mises en page du volet Tâches, choisir un masque prédéfini contenant
des éléments de texte comme décrit au chapitre 1. Ces cadres de texte sont nommés
cadres de texte à mise en page automatique.

• Créer un cadre de texte en utilisant l’outil Texte  dans la barre d’outils Dessin ou de la
barre d’outils Texte.

Utiliser des cadres de texte créés par la mise en page automatique
Assurez-vous que vous travaillez en mode Normal.

Cliquez dans le cadre de texte où il est écrit : cliquer pour ajouter un texte.

Saisissez ou collez votre texte dans le cadre.

Ces cadres de texte sont nommés cadres de texte à mise en page automatique. Voir aussi “Créer
des listes à puces et des listes numérotées”, page 22.

Utiliser des cadres de texte créés avec l’outil Texte
Assurez-vous que vous travaillez en mode Normal.

1) Cliquez sur l’icône  Texte  sur la barre d’outils  Dessin (Figure 1) ou cliquez sur  F2.
Par défaut, la barre d’outils Dessin est placée vers le bas de l’écran. Si la barre d’outils
Dessin avec l’icône  Texte n’est pas visible, choisissez  Affichage > Barres d’outils >
Dessin dans le menu principal.

Figure 1 : Barre d’outils Dessin
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2) Cliquez et glissez pour dessiner un cadre de texte sur la diapositive. Cette opération
définit la largeur. Ne vous souciez pas de la hauteur, car le cadre s’agrandira au fur et à
mesure que vous saisirez le texte.

3) Pour déplacer le cadre sur la diapositive, voir “Déplacer un cadre de texte”, page 8 ; pour
modifier sa largeur, voir “Redimensionner un cadre de texte”, page 8.

4) Relâchez le bouton de la souris quand vous avez terminé. Le pointeur apparaît alors
dans le  cadre de texte  qui  est  maintenant  en mode édition  (bordure  hachurée,  voir
Figure 2).

5) Saisissez ou collez votre texte dans le cadre.

6) Cliquez en dehors du cadre de texte pour le désélectionner.

Note

Il est aussi possible d’insérer des cadres dont le texte est aligné verticalement. 

Cliquez sur l’icône  dans la barre d’outils Dessin (Figure 1) pour créer un cadre 
de texte vertical. Ce choix n’est possible que si l'option Afficher les éléments 
d’interface pour l’écriture est-asiatique est cochée dans Outils > Options > 
Paramètres linguistiques > Langues.

Figure 2 : Utiliser les cadres de texte

Utiliser des cadres de texte créés avec la barre d’outils Texte
Il est possible de retrouver le même outil  avec la barre d’outils Texte. Pour la faire  apparaître,
sélectionnez Affichage > Barres d’outils > Texte (Figure 3).  Cliquez sur l’icône  Texte  et
procédez comme ci-dessus.

Figure 3 : Barre d’outils Texte

Sélectionner un cadre de texte

Dans le mode Normal, vous observerez que la flèche du pointeur se transforme en  lorsque la
souris survole le texte d’un cadre texte, cliquez. Le cadre de texte est maintenant en mode édition.
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Dans ce mode, une bordure hachurée est visible autour des bords du cadre. Pour sélectionner le
cadre de texte, appliquez l’une des deux méthodes suivantes.

Déplacez le pointeur de la souris sur sa bordure (Figure 5). Lorsque l’aspect du pointeur change,
cliquez à nouveau avec le bouton gauche

Appuyez une fois sur Échap.

Le mode édition est abandonné et des poignées de sélection bleues apparaissent.

Astuce
Il est quelquefois plus rapide de sélectionner un cadre en cliquant-glissant un 
rectangle de sélection autour de lui. Attention de ne pas sélectionner d’autres objets 
en même temps.

Déplacer un cadre de texte
Sélectionnez le cadre de texte comme indiqué ci-dessus.

Figure 4 : Déplacer un cadre de texte

Cliquez n’importe où dans le cadre ou sur la bordure hachurée (sauf sur les poignées bleues) et
tirez  pour  déplacer  le  cadre.  Une  copie  semi-transparente  du  cadre  vous  montre  son  futur
emplacement (Figure 4). Vous pouvez voir l’amplitude du déplacement dans la barre d’état.

Relâchez le bouton de la souris lorsque le cadre est à la bonne place. Pour retourner en mode
édition,  appuyer  sur  la  touche  Entrée,  ou  la  touche  F2,  ou  encore  cliquez sur  le  texte.  Pour
désélectionner l’objet, appuyez sur Échap ou cliquez en dehors du cadre.

Redimensionner un cadre de texte
Sélectionnez le cadre de texte comme indiqué ci-dessus.

Déplacez  le  pointeur  sur  l’une  des  poignées,  vous  remarquez  que  son  aspect  change  pour
indiquer la direction dans laquelle le cadre sera redimensionné.

Les  poignées  d’angle  modifient  simultanément  les  deux  dimensions  du  cadre,  alors  que  les
poignées sur les côtés modifient seulement une dimension. Lorsque les flèches à deux pointes
apparaissent, cliquez et glissez pour redimensionner le cadre.
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Astuce
Pour conserver les proportions d’un cadre de texte lors de son redimensionnement, 
maintenez la touche Maj enfoncée avant de cliquer-glisser.
Attention : relâchez le bouton de la souris avant la touche Maj.

Pour un réglage plus fin de la forme, la taille ou la position du cadre de texte, utilisez la boîte de
dialogue Position et taille plutôt que la souris. Sélectionnez le cadre de texte puis pressez F4 ou
choisissez  Format  >  Position  et  taille depuis  le  menu  principal  ou  encore  cliquez-droit  et
choisissez  Position  et  taille.  L’utilisation  de  cette  boîte  de  dialogue  est  commentée  dans  le
Chapitre 2 Utiliser des pages maîtresses, styles et modèles.

Figure 5 : Redimensionner un cadre de texte

Note

Par défaut, vous ne pouvez réduire la hauteur d'un cadre de texte en dessous de la 
hauteur minimale pour que le texte entier apparaisse. Pour cette raison, il est 
possible que, si vous réduisez la largeur du cadre, sa hauteur augmente. Voir l'option
Adapter la hauteur au texte de la boîte de dialogue Position et taille.

Utiliser la boîte de dialogue Position et taille
Pour un contrôle plus précis de la taille et de la position du cadre de texte, vous pouvez utiliser la
boîte de dialogue Position et taille (Figure 6).

Pour ceci, sélectionnez le cadre de texte, puis appuyez sur la touche F4, sélectionnez Format >
Position et taille ou faites un clic droit et choisissez Position et taille dans le menu contextuel.

Utilisation des onglets :

Position
La position d’un cadre de texte est définie dans l’onglet Position et taille. Saisissez les 
coordonnées X et Y par rapport à un point de base. L’unité de mesure employée est celle 
choisie dans Outils > Options > LibreOffice Impress > Général.

L’emplacement par défaut du point de base se situe dans le coin supérieur gauche de la 
diapositive. Vous pouvez changer temporairement de point de base en cliquant sur le point 
correspondant de la figure de droite, afin de faciliter le positionnement. Ce changement n’est 
valable que pour une seule utilisation et le point de base revient à son emplacement par défaut
lors de la fermeture de la boîte de dialogue Position et taille.

Vous pouvez empêcher les changements accidentels de position en cochant l’option Position 
de la section Protéger.
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Figure 6 : Boîte de dialogue Position et taille

Taille
La taille d’un cadre de texte est définie dans l’onglet Position et taille. Saisissez la largeur et la 
hauteur par rapport à un point de base. L’unité de mesure employée est celle choisie dans 
Outils > Options > LibreOffice Impress > Général. Pour conserver la proportion entre 
hauteur et largeur, cochez Proportionnel.

L’emplacement par défaut du point de base se situe dans le coin supérieur gauche du cadre. 
Vous pouvez changer temporairement de point de base en cliquant sur le point correspondant 
de la figure de droite, afin de faciliter le redimensionnement. Ce changement n’est valable que 
pour une seule utilisation et le point de base revient à son emplacement par défaut lors de la 
fermeture de la boîte de dialogue Position et taille.

Vous pouvez empêcher les modifications accidentelles de taille en cochant l’option Taille de la 
section Protéger.

Adapter la largeur au texte
Cochez cette option pour que la largeur du cadre de texte s’adapte automatiquement à son 
contenu. La largeur sera alors celle de la ligne de texte (texte séparé par les touches 
Maj+Entrée ou Entrée) la plus longue. La largeur du cadre et l’option Proportionnel ne sont 
alors plus modifiables.

Si l’option n’est pas cochée, vous pouvez réduire la largeur du cadre en dessous de celle de sa
ligne la plus longue : des retours à la ligne automatiques seront alors ajoutés.

Adapter la hauteur au texte
Cochez cette option (comportement par défaut) pour que la hauteur du cadre de texte s’adapte
automatiquement à son contenu. La hauteur sera alors la hauteur minimale pour que le texte 
entier soit visible. La hauteur du cadre et l'option Proportionnel ne sont alors plus modifiables.

Si l'option n'est pas cochée, vous pouvez réduire la hauteur du cadre en dessous de celle 
minimale pour afficher toutes les lignes. Cependant, le texte entier sera toujours affiché et 
débordera de son cadre. C’est pourquoi il est recommandé de conserver cette option.

Le comportement d’un cadre de texte vis-à-vis des paramètres des onglets Rotation et Inclinaison
et rayon d’angle est identique à celui des autres objets.
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Utiliser la boîte de dialogue Texte
Pour ouvrir la boîte de dialogue Texte, sélectionnez le cadre de texte, puis sélectionnez Format >
Texte ou faites un clic droit et choisissez Texte dans le menu contextuel.

Figure 7 : Boîte de dialogue Texte

Les options Adapter la largeur au texte et Adapter la hauteur au texte sont les mêmes que celles
de la boîte de dialogue Position et taille : voir Utiliser la boîte de dialogue Position et taille page 9.

Espacement du cadre
Permet de définir l’espacement du texte par rapport à son cadre.

Ancrage du texte
Cliquez dans le schéma sur la position à laquelle vous voulez que le texte soit ancré.

Pleine largeur
Ancre le texte sur toute la largeur du cadre.

Vous pouvez également ajouter des effets d’animation (clignotement, défilement,  défilement en
bidirectionnel, défilement puis arrêt) à votre texte en utilisant l’onglet Animation de texte (Figure 8).

Figure 8 : Animation d'un texte
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Vous pouvez choisir la direction de l’effet d’animation en cliquant sur l’une des quatre flèches à
droite. Les propriétés disponibles dépendent de l’effet choisi.

Formater un cadre de texte
Vous pouvez modifier les attributs du cadre de texte lui-même (et non du texte qui se trouve à
l’intérieur) en utilisant les outils Ligne et Remplissage.

Supprimer un cadre de texte
Sélectionnez le cadre de texte comme indiqué ci-dessus et pressez la touche Suppression.

Insérer du texte

Coller du texte
Vous pouvez insérer du texte provenant d’un autre document en le copiant et le collant dans un
cadre d’Impress. Le formatage du texte collé ne correspondra probablement pas à celui du texte
environnant ou des autres diapositives de la présentation. Dans la plupart des cas, il faudra rétablir
la cohérence entre les différents styles. Pour cela, vous disposez de plusieurs moyens exposés ci-
dessous.

Coller du texte non formaté
Il est préférable, généralement, de coller du texte non formaté et de le formater ensuite. Pour coller
du texte non formaté :

• pressez  Ctrl+Maj+V et  choisissez  Texte non formaté dans la  boîte de dialogue qui
apparaît ;

• cliquez  sur  le  petit  triangle  noir  près  du  symbole  Coller  dans  la  barre  d’outil
Standard et choisissez Texte non formaté.

Le texte non formaté sera alors formaté selon le style de mise en page à la position du curseur,
dans un cadre de texte à mise en page automatique, ou dans un cadre de texte normal, selon le
style graphique par défaut.

Formater le texte collé
Pour donner à un texte collé dans un cadre de texte à mise en page automatique, le même aspect
que le texte environnant, appliquez-lui le style de page qui convient :

Figure 9 : Barre d’outils Formatage du texte

1) collez le texte à l’emplacement choisi ; ne vous inquiétez pas de son aspect, vous allez
l’améliorer ;

2) sélectionnez le texte que vous venez de coller ; voir “Sélectionner du texte”, page  14
pour les détails ;

3) choisissez  Format > Formatage par défaut dans la barre de menu ; cette opération
affectera  l’un  des  neuf  styles  d’objets  de  présentation  au  texte ;  selon  l’endroit  où
l’insertion a été faite.

4) utilisez les quatre flèches de la barre d’outils Formatage du texte (cerclées de rouge sur
la  Figure  9)  pour  déplacer  le  texte  vers  la  bonne  position  et  lui  affecter  le  niveau
hiérarchique désiré ; la flèche de gauche remonte le texte d’un niveau hiérarchique (par
exemple, du niveau 3 vers le niveau 2), celle de droite descend le texte d’un niveau, les
flèches vers le haut et vers le bas modifient l’ordre des éléments de la liste ;
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5) formatez normalement les parties du texte (Attributs de police de caractères, tabulations,
etc.).

Un style d’objet graphique s’applique à l’ensemble du texte collé. Pour formater rapidement un
texte collé dans un cadre de texte normal, vous utiliserez les styles :

1) collez le texte à l’emplacement choisi ;

2) sélectionnez le texte que vous venez de coller (voir “Sélectionner du texte”, page 14 pour
les détails) ; les poignées de sélection doivent être visibles ;

3) double-cliquez sur le style d’objet graphique choisi ; le style est appliqué à tout le texte.

4) formatez normalement les autres parties du texte.

Astuce
Les styles d’objets de présentation sont très différents de ceux de LibreOffice Writer 
et sont appliqués d’une autre manière. Voir “Utiliser les styles pour formater un texte“,
page 15 pour plus de détails.

Insérer des caractères spéciaux
Pour insérer des caractères spéciaux tels que copyright, symboles mathématiques, géométriques,
monétaires, ou caractères d’une autre langue :

1) cliquez dans le texte à l’endroit où vous voulez insérer le caractère ;

2) choisissez Insertion > Caractères spéciaux ; la boîte de dialogue Caractères spéciaux
apparaît (Figure 7) ; si la barre d’outils Formatage du texte a été personnalisée et l’icône
Caractères  spéciaux  visible,  vous pouvez cliquer  dessus pour  ouvrir  la  boîte  de
dialogue  Caractères spéciaux ; vous pouvez faire  un clic  droit  et  choisir  Caractères
spéciaux dans le menu contextuel ;

3) choisissez la police et le jeu de caractères à l’aide des menus déroulants ;

4) cliquez sur le caractère que vous voulez insérer, après avoir éventuellement fait défiler la
liste ;

5) cliquez sur OK.

Astuce
Pour afficher les boutons manquants, faites un clic droit sur la barre d’outils et 
choisissez Boutons visibles, puis cliquez sur l’icône qui vous intéresse.

Figure 10 : Boîte de dialogue Caractères spéciaux

Les caractères seront insérés dans l’ordre de leur sélection, même si vous avez par erreur cliqué
sur  le  mauvais.  Cliquer  sur  autre caractère ne fera que l’ajouter  aux autres.  En cas  d’erreur,
cliquez sur Supprimer et tous les caractères sélectionnés seront effacés, puis reprenez la saisie.
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Vous pouvez aussi insérer tous les caractères sélectionnés puis supprimer les indésirables, car les
caractères spéciaux se comportent comme les autres.

Insérer des espaces et des tirets insécables
Pour que les mots séparés par des espaces ou des traits d’union ne soient pas répartis sur deux
lignes, ou qu’un mot soit coupé en deux en fin de ligne, vous pouvez insérer une marque spéciale
de formatage. Pour accéder aux options de marque de formatage, choisissez Insertion > Marque
de formatage.

Impress dispose de sept marques de formatage, dont quatre ne sont proposées que si l’option
Afficher les éléments d’interface pour l’écriture bidirectionnelle est activée (Outils > Options >
Paramètres linguistiques > Langues).

• Espace  insécable :  une  espace  insécable  entre  deux  mots  empêche  qu’ils  soient
répartis sur deux lignes. Pour insérer une espace insécable, vous pouvez aussi utiliser le
raccourci clavier Ctrl+Maj+Barre d’espace.

• Tiret insécable : deux mots séparés par un tiret insécable restent toujours sur la même
ligne.

• Tiret conditionnel : insère un tiret invisible à l’intérieur d’un mot qui apparaîtra et créera
un saut de ligne lorsqu’il deviendra le dernier caractère d’une ligne.

Note

La gestion des espaces insécables insérés automatiquement avant les signes de 
ponctuation double dans la langue française, se fait de la même manière que dans 
Writer : Outils > Options d’AutoCorrection > Options linguistiques, cochez 
Ajouter un espace insécable devant les signes de ponctuation spécifiques dans les 
textes français.

Lorsque l’option  Afficher les éléments d’interface pour l’écriture bidirectionnelle est  activée, les
quatre marques spéciales ci-dessous sont aussi proposées.

• Pseudo-ligature  sans  chasse :  insère  une  espace  invisible  dans  un  mot,  ce  qui
insérera un saut de ligne lorsque cette espace deviendra le dernier caractère de la ligne.

• Ligature  sans  chasse :  Certains  mots  contiennent  des  caractères  spéciaux  que
LibreOffice traite comme traits d’union. Cette marque insère une espace invisible dans
un mot, ce qui l’empêchera de se scinder lorsqu’il se trouve à la fin de la ligne.

• Marque gauche à droite et Marque droite à gauche : insèrent une marque de direction
de texte qui affecte la direction de tout texte suivant la marque.

Sélectionner du texte
Le texte doit être sélectionné avant de pouvoir être modifié :

• pour formater tout le texte d’un cadre, cliquez une fois sur le texte, puis sur la bordure du
cadre ;  les  poignées  de  redimensionnement  bleues  sont  affichées ;  maintenant,  tout
changement de format sera appliqué à l’ensemble du texte de ce cadre ;

• pour formater seulement une partie du texte d’un cadre, cliquez une fois sur le texte, puis
sélectionnez  la  portion  à  formater  en  cliquant-glissant  dessus,  la  zone  apparaît  en
négatif ;  vous  pouvez  aussi  employer  une  combinaison  de  touches  pour  faire  la
sélection :  placez le curseur vers le début de la sélection désirée,  pressez  Maj,  puis
utilisez les touches flèche pour étendre votre sélection ; les modifications de format ne
toucheront alors que la portion sélectionnée.
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Astuce

Pour sélectionner le texte mot par mot, pressez en même temps Ctrl et Maj pendant 
que vous étendez la sélection avec les flèches. Pour accélérer encore plus la 
sélection, vous pouvez combiner Ctrl avec Début ou Fin respectivement pour 
commencer au début ou arrêter à la fin de la ligne où le curseur est positionné.

• Pour sélectionner tout le texte, pressez Ctrl+A.

Formatage basique du texte
Une bonne  utilisation  du formatage  de  texte  donne  un  aspect  dynamique  et  cohérent  à  une
présentation et en améliore la compréhension tout en évitant les éléments susceptibles de distraire
l’auditoire.

Lorsque vous saisissez du texte, soit dans un cadre à mise en page automatique, soit dans un
cadre de texte normal, Impress lui affecte un ensemble d’attributs prédéfinis que l’on nomme style.
Le style utilisé dépend du niveau hiérarchique du point d’insertion dans le cas des cadres à mise
en  page  automatique.  Par  exemple,  si  vous  saisissez  un  élément  de  niveau  2,  Impress  le
formatera selon le style d’objets de présentation Plan 2, ou pour les cadres de texte normaux,
selon le style d’objet graphique par défaut.

Astuce

Il est parfois utile de pouvoir revenir au style de base, particulièrement lorsque vous 
avez fait une erreur et que vous ne savez pas comment la supprimer. Pour cela, 
sélectionnez manuellement le texte formaté et choisissez Format > Formatage par 
défaut dans la barre de menu, ou cliquez-droit et choisissez Par défaut.

Formater un texte peut vous amener à intervenir sur trois types d’attributs.

• Les attributs de caractère ; par exemple, la couleur des caractères.

• Les attributs de paragraphe ; par exemple, l’alignement.

• Les attributs de liste ; par exemple, le type de puces.

Dans quelques cas,  il  est  plus efficace et  plus rapide d’appliquer un formatage manuel,  mais
lorsque  vous  avez  besoin  d’appliquer  la  même  modification  à  de  nombreux  endroits  de  la
présentation, l’utilisation des styles est recommandée. Ces deux techniques sont décrites ici.

Note

Contrairement à LibreOffice Writer, où il est recommandé d’utiliser le plus possible 
les styles, avec Impress, le formatage manuel doit être employé plus souvent. Dans 
Impress, les styles d’objets de présentation étant fixes, il n’est pas possible, par 
exemple, d’avoir deux styles Plan 2 différents ou plusieurs types de puces sur le 
même niveau hiérarchique. D’autre part, les styles de caractère n’étant pas 
supportés, l’emploi du formatage manuel est rendu obligatoire pour modifier des 
portions du texte.

Attention
Lorsque vous appliquez un style d’image, tous les attributs de tous les onglets 
s’appliquent à l’objet sélectionné, même si vous n’avez sélectionné que son texte. Un
style d’image Impress est donc différent d’un style de paragraphe Writer dont les 
attributs ne concernent que le texte, et ce, bien que les noms des styles soient 
identiques.

Utiliser les styles pour formater un texte

Deux  catégories  de  styles  coexistent  dans  Impress :  les  Styles  de  présentation et  les  Styles
d’images. Les  Styles de présentation sont utilisés pour le texte inséré dans un cadre à mise en
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page automatique, les arrière-plans des masques et les objets d’arrière-plan. Pour le texte inséré
dans un autre cadre de texte ou un objet graphique vous devez utiliser un des Styles d’images.

Ce chapitre sera surtout  consacré aux  Styles de présentation.  Pour plus d’information sur les
Styles d’images, voir le Chapitre 6, Mettre en forme des objets graphiques.

Modifier un style de présentation
Pour modifier un style de présentation, suivez les étapes ci-dessous :

1) ouvrez la fenêtre Styles et formatage (Figure 11) en pressant  F11 ou en sélectionnant
Format > Styles et formatage dans la barre de menu ;

2) assurez-vous que l’icône Styles de présentation  est sélectionnée ;

3) cliquez-droit sur le style à modifier et choisissez Modifier dans le menu contextuel. La
partie haute de la boîte de dialogue pour modifier un style de présentation est montrée
sur la Figure 12.

Figure 11 : Les Styles de présentation

Figure 12: Boîte de dialogue pour modifier un style de présentation

La  boîte  de  dialogue  de  modification  contient  quatorze  onglets  (plus  un  pour  la  typographie
asiatique si elle a été activée dans Outils > Options > Paramètres linguistiques > Langues), qui
peuvent être classés en deux groupes : ceux qui définissent le formatage du texte et ceux qui
définissent les propriétés des arrière-plans des masques et les objets d’arrière-plan.

Il n’y a aucune différence entre les attributs qui déterminent un style et ceux appliqués manuel-
lement  sur  des  portions  de  texte.  En  fait,  les  boites  de  dialogues  ouvertes  directement  pour
formater un fragment du texte sont les mêmes que celles qui sont ouvertes depuis les onglets de
la Figure 12. Donc, lorsque vous maîtriserez le formatage de texte, vous saurez comment créer et
modifier un style.

• Pour les onglets Police et Effets de caractère, voir Formater des caractères, page 17.

• Pour les onglets  Retraits et espacement,  Alignement et  Tabulation, voir  Formater des
paragraphes, page 19.

• Pour les onglets Puces, Type de numérotation, Images et Personnaliser, voir Créer des
listes à puces et des listes numérotées, page 22.
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Dans la boîte de dialogue de modification, certains onglets concernent le formatage du texte, et
d’autres le formatage de l’arrière-plan et des objets d’arrière-plan, lequel est décrit en détail dans
le Chapitre 6, Mettre en forme des objets graphiques.

Mise à jour d’un style à partir d’une sélection
Pour mettre à jour un style à partir d’une portion de texte que vous venez de modifier :

1) sélectionnez dans le cadre de texte l’élément dont vous voulez adopter le format pour
l’affecter à un style ;

2) dans la boîte de dialogue Styles et formatage (Figure 11), sélectionnez le style que vous
voulez mettre à jour puis cliquez sur l’icône Actualiser le style .

Appliquer un style d’objets de présentation
Pour appliquer un style d’objets de présentation, placez le paragraphe au niveau hiérarchique qui
convient comme expliqué dans la section  Changer l’ordre des lignes ou le niveau hiérarchique,
page 26. Cette démarche est différente de celle avec LibreOffice Writer où vous choisissez le style
désiré dans la boîte de dialogue Style et formatage.

Formater des caractères

Pour afficher les options de formatage de caractère, choisissez Format > Caractère ou cliquez sur
l’icône Caractère  sur la barre d’outils Formatage de texte ou encore cliquez-droit et choisissez
Caractère et la boîte de dialogue Caractère s’ouvre (Figure 13). Si la barre d’outils Formatage de
texte n’est pas visible, choisissez  Affichage > Barres d’outil > Formatage de texte. Par défaut
cette barre d’outils est visible en mode édition et disparaît après sélection d’un autre objet. Notez
que les styles de caractère n’existent pas dans Impress.

Figure 13: Onglet police dans la boîte de dialogue Caractère

Vous pouvez également formater rapidement des caractères en utilisant les raccourcis clavier ou
en faisant un clic droit et en choisissant Police, Taille, Style, Alignement ou Interligne, ou avec
les contrôles de la barre d’outils Formatage de texte.
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Onglet Police
Utilisez l’onglet  Police pour choisir le type de police, ses attributs de base (Italique,  Gras, etc.)
ainsi que sa taille. Un échantillon de la police est affiché dans le bas de la boîte de dialogue. Vous
pouvez aussi spécifier la langue affectée au texte sélectionné ou au style. Cet onglet  Police est
aussi disponible lorsque vous créez ou modifiez un style de présentation ou un style d’images.

Si  l’option  Afficher  les  éléments  d’interface pour  l’écriture  bidirectionnelle est  active  (Outils  >
Options > Paramètres linguistiques > Langues), l’onglet Police prend l’aspect de la Figure 14.
La page est divisée en trois parties pour les polices de texte occidental, asiatique et de scripts
complexes. Chaque partie a les mêmes fonctionnalités que la boîte de dialogue de la Figure 13,
tout en vous permettant de spécifier les polices de texte asiatique et CTL avec leurs attributs.

Figure 14: Langues asiatiques validées dans la boîte de
dialogue Caractères

Onglet Effets de caractères
Utilisez l’onglet Effets de caractères Figure 15 pour appliquer des effets spéciaux au texte, tels que
surlignage et soulignage, couleur, ombre, etc. Comme pour l’onglet Police, un échantillon de texte
est affiché dans le bas de la boîte de dialogue, donnant rapidement un aperçu des effets choisis.
Cet onglet  Effets de caractères est aussi disponible lorsque vous créez ou modifiez un style de
présentation ou un style d’images.

Figure 15: Effets de caractères dans la boîte de dialogue
Caractère
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Onglet Position
L’onglet  Position (Figure 16) propose d’autres options pour personnaliser un texte. Utilisez cet
onglet pour fixer la position du texte par rapport au niveau de référence de la ligne lorsque vous
voulez insérer des indices ou des exposants. Cet onglet n’est pas disponible lorsque vous créez
ou modifiez un style de présentation ou un style d’objet graphique.

Pour créer un indice ou un exposant :

1) cochez la case Indice ou Exposant ;

2) choisissez le pourcentage de déplacement vertical du texte : élever ou abaisser de ;

3) choisissez le pourcentage de diminution de la taille du texte : taille relative.

Figure 16: Position du caractère dans la boîte de dialogue
Caractère

Le  pourcentage  de  déplacement  vertical  du  texte  par  rapport  à  la  ligne  peut  être  réglé
automatiquement en cochant la case Automatique.

Deux attributs supplémentaires peuvent être affectés au texte depuis cet onglet.

• Échelle de largeur donne le pourcentage de compression ou d’expansion du texte par
rapport à la largeur de référence de la police.

• Espacement entre les caractères de la police, défini en nombre de points. Cocher la
case Paire de crénage force Impress à modifier l’espacement entre certaines paires de
caractères pour en améliorer l’aspect. Par exemple, lorsque vous écrivez un V suivi d’un
A (VA), l’espacement entre les deux lettres est réduit (fort crénage) comme on peut le
voir aisément en comparant avec le couple VS qui n’est pas une paire de crénage.

Formater des paragraphes

Pour  afficher  les  options  de  formatage  de  paragraphe,  choisissez  Format  >  Paragraphe ou
cliquez sur l’icône Paragraphe  de la barre d’outils  Formatage de texte (Figure 9) ou encore
cliquez-droit et choisissez Paragraphe : la boîte de dialogue Paragraphe s’ouvre (Figure 17). Si la
barre  d’outils  Formatage  de  texte n’est  pas  visible,  choisissez  Affichage > Barres
d’outils > Formatage de  texte.  Par  défaut  cette  barre  d’outils  est  visible  en mode édition  et
disparaît après sélection d’une autre objet. Si les options  Afficher les éléments d’interface pour
l’écriture  est-asiatique et  Afficher  les  éléments  d’interface  pour  l’écriture  bidirectionnelle sont
actives  (Outils  >  Options  >  Paramètres  linguistiques  >  Langues),  un  onglet  nommé
Typographie asiatique est aussi affiché.
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Onglet Retraits et espacement
L’onglet Retraits et espacement et ses quatre sections est le premier onglet de la boîte de dialogue
Paragraphe.  Cet  onglet  est  aussi  disponible  lorsque  vous  créez  ou  modifiez  un  Style  de
présentation ou un Style d’images.

• Retrait : modifie le retrait du texte avant et après (à gauche et à droite pour les langues
écrivant de la gauche vers la droite), ainsi que le retrait propre à la première ligne.

• Espacement : détermine l’espacement au-dessus et en dessous du paragraphe.

• Interligne : modifie l’espacement entre deux lignes. Notez que le choix de l’espacement
Proportionnel exige  de  spécifier  le  pourcentage  de  la  hauteur  d’une  ligne  à  utiliser
comme espacement : 100 % correspond à une simple ligne, 200 % à une double ligne,
50 % à une demi-ligne. Si Typographique est choisi, saisissez la valeur de l’espacement
dans l’unité de mesure que vous avez déclarée par défaut.

• La  zone  de  droite  fournit  un  aperçu  de  l’effet  des  paramètres  avant  qu’ils  soient
appliqués.

Astuce
Fixer un interligne inférieur à 100 % peut permettre de tasser un texte dans un cadre.
Prenez garde tout de même, car une valeur trop faible peut nuire à la lisibilité.

Figure 17 : Retraits et espacement dans la boîte de dialogue
Paragraphe

Astuce
Vous pouvez modifier l’unité de mesure par défaut, par exemple de pouces à 
centimètres, depuis Outils > Options > LibreOffice Impress > Général.

Figure 18 : Alignement dans la boîte de dialogue Paragraphe
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Onglet Alignement
L’onglet  Alignement est présenté Figure 18. Utilisez cet onglet pour définir le mode d’alignement
du paragraphe : Gauche, Droite, Centre, ou Justifié. Un aperçu montre les effets du changement.
Cet onglet est aussi disponible lorsque vous créez ou modifiez un Style de présentation ou un
Style d’images.

Note

Si l’option Afficher les éléments d’interface pour l’écriture bidirectionnelle est active 
(Outils > Options > Paramètres linguistiques > Langues), un choix 
supplémentaire – Orientation du texte – apparaît au bas de la boîte de dialogue, vous
pouvez choisir Gauche-à-droite, Droite-à-gauche, ou Utiliser les paramètres de 
l’objet supérieur.

Les mêmes options d’alignement sont accessibles depuis les icônes d’alignement  sur
la barre d’outils Formatage de texte (Figure 9).

Onglet Tabulations
L’onglet Tabulations est présenté Figure 19. Utilisez cet onglet pour définir la position des taquets
de tabulation dans un paragraphe. Cet onglet est aussi disponible dans les boîtes de dialogue des
styles de présentation et d’images.

Pour  supprimer  un taquet  de tabulation,  sélectionnez-le  dans la  liste et  cliquez sur  le  bouton
Supprimer. Pour effacer toutes les marques de tabulation, cliquez sur le bouton Tout supprimer.

Figure 19 : Tabulations dans la boîte de dialogue
Paragraphe

Pour créer un nouveau taquet de tabulation :

1) saisissez la longueur de la tabulation dans la boîte d’édition à gauche ;

2) sélectionnez le type, si vous choisissez Décimale, l’alignement se fera sur le séparateur
décimal ;  précisez  dans la  case au-dessous le  caractère qui  sera considéré  comme
virgule ;

3) choisissez un caractère de remplissage qui sera reproduit entre le point d’insertion du
caractère de tabulation et le taquet ; vous pouvez choisir n’importe quel caractère pour
ce remplissage ;

4) cliquez sur le bouton Nouveau pour valider ce nouveau taquet de tabulation.
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Onglet Typographie asiatique
Utilisez cet onglet pour  établir les propriétés suivantes relatives aux changements de ligne. Cet
onglet est aussi disponible dans les boîtes de dialogue styles de présentation et styles d’images.
Les options disponibles pour les retours à la ligne dans les textes en langue asiatiques sont :

• appliquer la liste des caractères interdits en début et en fin de ligne ;

• autoriser la ponctuation en retrait ;

• appliquer l’espacement entre les textes asiatiques, latins et complexes.

Figure 20 : Typographie asiatique dans la boîte de dialogue
Paragraphe

Créer des listes à puces et des listes numérotées

La méthode pour créer des listes à puces et des listes numérotées varie en fonction du type de
cadre de texte utilisé, bien que les outils utilisés pour gérer la liste et personnaliser son aspect
soient les mêmes.

Dans les cadres de texte à mise en page automatique, les styles de plan disponibles sont, par
défaut, des listes à puces. Dans le cas d’un cadre de texte ordinaire, une étape supplémentaire est
nécessaire pour créer une liste à puces.

Créer des listes dans un cadre de texte à mise en page automatique
Certains cadres de texte inclus dans les Mises en page disponibles sont déjà formatés avec des
listes à puces ; les seules étapes nécessaires pour créer une liste sont donc :

1) depuis le panneau Mises en page du volet Tâches, choisissez une des mises en page
qui propose au moins un  contenu ; chaque contenu est par défaut un cadre de texte
avec liste à puces ;

2) cliquez sur le cadre de texte où est écrit : « • Cliquez pour ajouter un texte » ;

3) saisissez le texte, puis pressez Entrée pour commencer une nouvelle ligne à puce.

Le type de liste par défaut est une liste à puces. Pour personnaliser l’aspect de la liste, ou pour
passer d’une liste à puces à une liste numérotée, voir la section Modifier l’aspect de la liste, page
23.

Astuce

Appuyer sur Maj+Entrée pour commencer une nouvelle ligne sans puce ou numéro. 
La nouvelle ligne aura le même retrait que la précédente avec le même style de plan.
Cliquez sur l’icône (Dés)Activer les puces de la barre d’outils Formatage de texte 
pour faire apparaître ou disparaître les puces. Si la barre d’outils Formatage de texte 
n’est pas visible, choisissez Affichage > Barres d’outil > Formatage de texte sur la
barre de menu.

Créer des listes dans d’autres cadres de texte
Pour créer une liste dans un cadre de texte, suivez ces étapes :

1) placer le curseur dans le cadre de texte en mode édition ;

2) cliquez sur le bouton  (Dés)Activer les puces  de la barre d’outils  Formatage de
texte ;
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3) saisissez le texte et pressez Entrée pour commencer une nouvelle ligne à puces.

Pour changer l’aspect d’une liste, voir la section Modifier l’aspect de la liste, page 23.

Créer un nouveau niveau hiérarchique
1) Pressez Entrée pour commencer une nouvelle ligne si nécessaire.

2) Pressez la  Touche de Tabulation ou cliquez sur les flèches de retrait  de la barre
d’outils  Formatage de texte. Chaque fois que vous pressez la touche de Tabulation ou
cliquez sur la flèche droite, la ligne s’abaisse au niveau hiérarchique suivant. L’appui sur
Entrée crée une nouvelle ligne au même niveau que la précédente. Pour revenir  au
niveau hiérarchique supérieur, pressez Maj+Touche de tabulation ou cliquez sur la flèche
gauche.

Note
L’appui sur les touches de tabulation pour changer le niveau hiérarchique ne 
fonctionne que si le curseur est en début de paragraphe. Sinon un caractère 
Tabulation est inséré au niveau du curseur.

Dans les cadres de texte à mise en page automatique, un changement de niveau correspond
automatiquement à un changement de style, ainsi le niveau 2 correspond à Plan 2, le niveau 3
correspond à Plan 3, etc. En conséquence, changer de niveau induit automatiquement d’autres
modifications (par exemple, taille de police, type de puce et ainsi de suite).

Attention N’essayez pas de modifier le niveau hiérarchique en sélectionnant le texte et en 
cliquant le style de plan désiré comme vous le feriez avec LibreOffice Writer. Le 
mode de fonctionnement des Styles de présentation sous Impress ne le permet pas.

Modifier l’aspect de la liste
Vous  pouvez  entièrement  personnaliser  l’aspect  d’une  liste,  modifier  le  type  de  puces  ou  de
numérotation d’une liste entière ou seulement d’une entrée. Toutes les modifications peuvent être
faites à l’aide de la boîte de dialogue  Puces et  numérotation,  que l’on ouvre en sélectionnant
Format > Puces et numérotation ou en cliquant sur l’icône Puces et numérotation  dans la
barre d’outils de Formatage du texte.

Sélection des entrées
Pour modifier toute la liste :

1) sélectionnez toute la liste ou cliquez sur la bordure grise du cadre de texte afin que les
poignées de redimensionnement bleues soient affichées ;

2) sélectionnez  Format > Puces et numérotation sur  la  barre  de  menu ou  cliquez  sur
l’icône Puces et numérotation  dans la barre d’outils de formatage des textes ;

3) la boîte de dialogue  Puces et numérotation (Figure 21) contient cinq onglets : Puces,
Type de numérotation, Images, Position et Personnaliser ; faites votre choix parmi toutes
ces possibilités.

– Puces : huit types au choix.

– Type de numérotation : huit types au choix.

– Images : permet de remplacer les puces par une série de graphismes.
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Figure 21 : La boîte de dialogue Puces et numérotation

Nous verrons plus loin comment ajouter d’autres puces ou styles de numérotation aux styles livrés
avec Impress.

Pour modifier une seule ligne, cliquer quelque-part sur la ligne pour y placer le curseur et suivez
les étapes 2 et 3 ci-dessus.

Si la liste a été créée dans un cadre de texte à mise en page automatique, on peut aussi modifier
la liste entière en modifiant les styles de mise en page. Utilisez cette méthode prudemment, car
ces modifications apparaîtront sur toutes les diapositives utilisant le style. Cela reste la méthode la
plus efficace pour uniformiser la présentation. Les onglets ayant trait à la gestion des listes sont
décrits ci-dessous.

Onglet Position
Utilisez l’onglet  Position (Figure 22) pour régler le retrait et l’espace entre la puce et le texte qui
l’accompagne.  Cet  onglet  est  particulièrement  efficace  utilisé  en  combinaison  avec  l’onglet
Personnaliser.

Pour paramétrer un niveau hiérarchique de la liste, sélectionnez-le d’abord sur le côté gauche de
la  fenêtre.  Sélectionnez  les  niveaux  1 – 10 pour  traiter  simultanément  tous  les  niveaux.  Puis
choisissez le Retrait, distance entre la marge et la puce (ou le numéro). Si vous cochez Relatif, la
valeur du retrait sera alors mesurée par rapport au niveau précédent et non plus par rapport à la
marge.

Choisissez la Largeur de la numérotation, distance entre la puce ou le numéro et le texte qui suit.
Si le numéro est aligné à droite ou centré (paramètre ci-dessous), ce paramètre permet de régler
la largeur de l’espace réservé pour loger tous les chiffres du numéro.
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Figure 22 : Puces et numérotation – Onglet Position

Le  paramètre  Alignement  de  la  numérotation n’est  utile  que  lorsque  vous  créez  une  liste
numérotée : il permet de spécifier l’alignement des nombres. Par exemple, vous pouvez vouloir les
cadrer à droite pour aligner les nombres à plus d’un chiffre.

Astuce

Pour apprécier pleinement le fonctionnement du paramètre Alignement de la 
numérotation, essayez de créer une liste numérotée de plus de dix éléments en 
choisissant un alignement à droite. Réglez l’espace pour deux ou plusieurs chiffres à 
l’aide de Largeur de la numérotation.

L’onglet Position n’est pas disponible lorsque vous modifiez un Style de présentation ou un Style
d’images,  vous  pouvez  cependant  obtenir  les  mêmes  effets  en  utilisant  l’onglet  Retraits  et
espacement de la boîte de dialogue Paragraphe (Figure 17, page 20) pour créer ou modifier une
diapositive.

Onglet Personnaliser
Utilisez l’onglet Personnaliser (Figure 23) pour modifier les niveaux hiérarchiques.

Figure 23 : Puces et numérotation – Onglet Personnaliser

Les  options  disponibles  sur  cet  onglet  diffèrent  selon  le  type  de  repère  choisi  pour  la  liste.
Sélectionnez d’abord le niveau à modifier dans la liste sur le côté gauche de la fenêtre. Pour traiter
simultanément tous les niveaux, sélectionnez les niveaux 1 – 10. Les niveaux étant organisés en
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une structure hiérarchique, la modification, par exemple, des attributs de police de l’un d’entre eux
se répercute sur l’ensemble des niveaux inférieurs.

Selon  le  type  de  repère  choisi  (puces,  numéros,  images),  un  certain  nombre  des  options  ci-
dessous seront proposées sur l’onglet Personnaliser.

• Devant : saisissez le texte qui apparaîtra devant le numéro, étape, par exemple.

• Derrière : saisissez le texte qui apparaîtra après le numéro, un point, par exemple.

• Couleur : choisissez la couleur du repère de liste, numéro ou puce.

Figure 24 : Liste imbriquée avec à la fois numéros et puces.

• Taille  relative :  définissez la  taille  du numéro par  rapport  à celle  des  caractères du
paragraphe de la liste.

• Commencer avec : saisissez le premier numéro de la liste, si vous voulez, par exemple
que la liste commence à 4 au lieu de 1.

• Caractère : cliquez sur ce bouton pour choisir un caractère spécial à la place de la puce.

• Images : cliquez sur le bouton Sélectionner pour choisir, dans une galerie, un dessin,
ou sur le disque dur, un fichier, qui sera utilisé comme repère par la liste.

• Largeur et Hauteur : spécifiez les dimensions du repère graphique.

• Proportionnel : si vous cochez cette case, le rapport entre la largeur et la hauteur du
repère graphique sera maintenu constant.

Le côté droit de la fenêtre offre un aperçu des modifications réalisées. Pour revenir aux valeurs de
cet onglet précédant l’ouverture de la boite de dialogue, cliquez sur le bouton Réinitialiser dans
l’angle en bas à droite.

Grâce à l’onglet Personnaliser, vous pouvez construire des listes complexes, par exemple une liste
imbriquée avec à la fois numéros et puces (Figure 24).

Changer l’ordre des lignes ou le niveau hiérarchique
En mode  Normal ou en mode  Plan,  cliquez une fois dans une ligne de texte pour y placer le
curseur, et à l’aide des icônes de flèche de la barre d’outils Formatage du texte, déplacez le texte
et affectez-lui le niveau hiérarchique que vous désirez.

L’icône de flèche à gauche remonte l’élément de la liste d’un niveau (par exemple de Plan 3 vers
Plan 2), l’icône de flèche à droite le descend d’un niveau. Les flèches haut et bas déplacent la
ligne dans la liste. Une éventuelle numérotation est mise à jour automatiquement.
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Astuce
En positionnant le curseur en début de paragraphe, vous pouvez aussi utiliser la 
touche Tabulation seule ou combinée avec Maj pour changer le niveau hiérarchique 
d’une ligne dans la liste.

Utiliser les tableaux

Le tableau est un moyen efficace pour transmettre rapidement une information structurée, c’est
donc  un  outil  important  pour  la  création  d’une  présentation.  Vous  pouvez  créer  un  tableau
directement  dans Impress plutôt  que d’incorporer  une feuille  de calcul  LibreOffice  Calc ou un
tableau LibreOffice Writer dans votre présentation. Dans quelques cas, cependant, pour avoir des
fonctionnalités plus étendues, il peut être utile d’incorporer une feuille de calcul LibreOffice Calc.
Les tableaux fournis par Impress ont des fonctionnalités limitées.

De nombreux dessins de tableaux sont prédéfinis dans la section Ébauches de tableaux du volet
Tâches (Figure 28).

Créer un tableau
Initialement, le tableau occupera le premier cadre à mise en page automatique encore vide, ou à
défaut, est placé au centre de la diapositive. Pour le modifier, référez-vous à la section Modifier un
tableau, page 29 de ce guide.

Avec les mises en page automatiques
En  utilisant  les  mises  en  page  automatique  proposées  dans  le  volet  Tâches,  vous  pouvez
rapidement organiser votre diapositive et prévoir dès le départ la position de votre tableau et de
votre texte, par exemple avec 2 contenus côte à côte.

Figure 25 : Insérer un tableau avec une mise en page
automatique

1) Choisir une mise en page contenant l’outil Insérer un tableau (Figure 25).

2) Cliquez sur le bouton Insérer un tableau du cadre à mise en page automatique.

3) La  boîte  de  dialogue  Insérer  un  tableau (Figure  26)  s’ouvre  et  vous  pouvez  définir
directement vos nombres de colonnes et de lignes.

Figure 26 : Boîte de dialogue Insérer un tableau
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Avec les options des barres d’outils
• Vous  pouvez  créer  un  tableau  en  choisissant  Insertion  >  Tableau dans  le  menu

principal ou en cliquant sur l’icône  Tableau  dans la barre d’outils  Standard.  La
boîte de dialogue Insérer un tableau (Figure 26) s’ouvre et vous pouvez saisir le nombre
de lignes et de colonnes.

• Vous pouvez aussi cliquer sur le petit triangle noir à côté de l’icône Tableau  dans
la barre d’outils Standard.

a) Lorsque vous survolez la grille affichée,  un tableau coloré se dessine,  c’est  l’outil
graphique d’insertion de tableau (Figure 27).

b) Déplacez la souris vers la droite et vers le bas jusqu’à l’obtention du nombre désiré de
lignes et de colonnes colorées.

c) Cliquez dans la dernière case avec le bouton gauche pour insérer le tableau.

Figure 27 : Outil graphique d’insertion de tableau

Avec une Ébauche de tableau
Sélectionnez la diapositive qui doit contenir le tableau. Modifiez la mise en page si nécessaire pour
réserver la place.

1) Sélectionnez Affichage > Volet Tâches.

2) Sélectionnez Ébauches de tableau (Figure 28) dans le volet Tâches.

3) Sélectionnez  un  des  styles  prédéfinis  qui  ne  diffèrent  que  par  leurs  couleurs.  Vous
pourrez changer les couleurs plus tard, mais essayez néanmoins de choisir un tableau
proche de celui que vous voulez.

4) La boîte de dialogue  Insérer un tableau (Figure 26) s’ouvre et vous pouvez saisir  le
nombre de lignes et de colonnes.
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Figure 28 : Volet Tâches – Ébauches de tableaux

Modifier un tableau
Une fois  le  tableau  inséré  dans la  diapositive,  vous  pouvez en  contrôler  l’aspect,  la  taille,  la
position, à l’aide des options du volet Tâches (Figure 25), de la barre d’outils Tableau ou de la
boîte de dialogue Position et taille.

Options de l’Ébauche de tableau
Les  options  ci-dessous  sont  disponibles  dans  la  section  Afficher de  la  rubrique  Ébauche  de
tableau du volet Tâches.

• Ligne d’en-tête : sélectionnée par défaut, cette option ajoute une première ligne avec
une couleur de remplissage différente de celle des autres lignes.

• Ligne de total : modifie l’arrière-plan de la dernière ligne afin de la mettre en évidence.

• Lignes colorées : sélectionnée par défaut, cette option colore alternativement les lignes
avec des couleurs différentes pour en faciliter la lecture.

• Première colonne :  met  la  première  colonne en évidence avec un arrière-plan plus
foncé.

• Dernière colonne : met la dernière colonne en évidence avec un arrière-plan plus foncé.

• Colonnes colorées : colore alternativement les colonnes avec des couleurs différentes.

Barre d’outils tableau
Lorsqu’un tableau est sélectionné, huit poignées de sélection bleues apparaissent sur ses bords et
la barre d’outils Tableau (Figure 29) s’affiche. Si nécessaire, vous pouvez afficher cette barre avec
Afficher > Barres d’outils > Tableau. La barre d’outils Tableau contient l’essentiel des outils dont
vous aurez besoin pour manipuler un tableau. Ils sont décrits ci-dessous.
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1 Tableau 7 Fusionner les cellules 13 Insérer une ligne
2 Style de ligne (bordure) 8 Scinder les cellules 14 Insérer une colonne
3 Couleur de ligne (bordure) 9 Optimiser 15 Supprimer une ligne
4 Bordures 10 Alignement du Texte, haut 16 Supprimer une colonne
5 Style de remplissage 11 Alignement du Texte, centré 17 Ébauche de tableau
6 Choix du style de remplissage 12 Alignement du Texte, bas 18 Propriétés du tableau

Figure 29 : La barre d’outils Tableau

Tableau
Crée un nouveau tableau dans la diapositive sélectionnée. Ce bouton ouvre la boîte de 
dialogue Insérer un tableau dans laquelle vous pouvez choisir le nombre de lignes et de 
colonnes désiré. Vous pouvez aussi cliquer sur le petit triangle noir à côté de l’icône pour ouvrir
un outil graphique d’insertion de tableau (Figure 27). Pour utiliser cet outil, déplacez la souris 
vers la droite et vers le bas jusqu’à l’obtention du nombre de lignes et de colonnes désiré, puis 
cliquez dans la case avec le bouton gauche.

Style de ligne
Permet de modifier le style de bordure pour les cellules sélectionnées. Ouvre une liste 
déroulante proposant une série de styles prédéfinis.

Couleur de ligne (de la bordure)
Propose un choix de couleurs pour la bordure des cellules sélectionnées.

Bordures
Offre une série de combinaisons de bordures prédéfinies. Ces bordures seront appliquées aux 
cellules sélectionnées. Si vous ne trouvez pas la bordure qui vous intéresse, vous devez 
utiliser la boîte de dialogue Propriétés du tableau, voir ci-dessous.

Style de remplissage
Dans le menu déroulant, choisissez d’abord le type de remplissage des cellules sélectionnées :
Invisible, Couleur, Dégradé, Hachure, ou Bitmap. Selon la sélection, le menu déroulant des 
remplissages sera garni par les combinaisons disponibles. Voir le Chapitre 6, Mettre en Forme 
des Objets Graphiques pour plus de détails sur la façon de gérer les Styles de remplissage.

Sélection du style de remplissage
Propose dans un menu déroulant une sélection de valeurs, laquelle sélection varie selon le 
style de remplissage défini : couleurs, dégradés, hachures ou images.

Fusionner les cellules
Fusionne les cellules sélectionnées en une seule cellule. Notez que leur contenu est aussi 
fusionné.

Scinder les cellules
Assurez-vous que le curseur est placé dans la cellule à scinder, puis cliquez pour ouvrir la 
boîte de dialogue Scinder les cellules (Figure 30). Choisissez le nombre de cellules désiré et la
façon dont la scission est faite (horizontalement ou verticalement). Lorsque vous scindez 
horizontalement, vous pouvez cocher En proportions égales pour obtenir des cellules de 
largeur identique. Le contenu de la cellule scindée est conservé dans la cellule d’origine, celle 
de gauche ou celle de dessus.
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Figure 30 : Boîte de dialogue Scinder les cellules

Optimiser
Attribue des dimensions égales aux cellules sélectionnées soit horizontalement, soit 
verticalement. Si vous voulez optimiser le tableau entier, cliquez-droit sur la bordure du tableau
et choisissez Ligne > Répartir régulièrement ou Colonne > Répartir régulièrement dans le 
menu contextuel.

En haut / Centre (Vertical) / En bas
Permet de régler l’alignement vertical du texte dans les cellules sélectionnées avec les valeurs 
En haut, Centre, ou En bas. Pour appliquer l’alignement au tableau entier, cliquez-droit sur la 
bordure du tableau et choisissez Cellules, puis le type d’alignement désiré.

Insérer ou Supprimer Lignes et Colonnes
Quatre boutons de la barre d’outils Tableau vous permettent de faire ces opérations. Les lignes
et les colonnes sont insérées au-dessous et à droite de la cellule sélectionnée. Vous pouvez 
insérer des lignes et des colonnes à la fin depuis le menu déroulant obtenu en cliquant-droit 
sur la bordure du tableau. Les commandes d’insertion et de suppression se trouvent dans les 
menus Ligne et Colonne.

Ébauche de tableau
Ouvre la section Ébauche de tableau dans le volet Tâches.

Propriétés du tableau
Cliquez sur l’icône Propriétés du tableau sur la barre d’outils Tableau (Figure 29) pour ouvrir la 
boîte de dialogue Formatage des cellules (Figure 31) qui contient quatre onglets.

• Police : choix de la police de caractères, ses attributs de base (Italique, Gras, etc.) ainsi
que sa taille. Un exemple de la police est affiché dans la partie basse de la boîte de
dialogue. Vous pouvez aussi sélectionner la langue. Voir Onglet Police, page 18 pour les
détails des différentes options.

• Effets  de  caractères :  permet  d’appliquer  des  effets  spéciaux  au  texte,  tels  que
surlignage et soulignage, couleur, ombre, etc. Comme pour l’onglet police, un exemple
est affiché dans la partie basse de la boîte de dialogue, permettant un rapide contrôle
des effets à appliquer. Voir  Onglet Effets de caractères, page  18 pour les détails des
différentes options.

• Bordures :  utilisé pour définir  des propriétés évoluées non disponibles dans la barre
d’outils  Tableau, telles que l’espacement avec le contenu et le paramétrage de chaque
portion de la bordure. Cet onglet fournit aussi les mêmes options de style et couleur de
ligne que les boutons de la barre d’outils Tableau.
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Figure 31 : Boîte de dialogue Propriétés du tableau

Note
Il n’est actuellement pas possible de définir des bordures diagonales pour les 
tableaux d’Impress.

• Arrière-plan :  modifie  l’arrière-plan des cellules sélectionnées et  propose les mêmes
fonctions que  Style de remplissage et  Sélection du style de remplissage de la barre
d’outils Tableau.

Note
La boîte de dialogue Propriétés du tableau peut aussi être affichée depuis le menu 
contextuel qui s’ouvre en cliquant-droit sur la bordure du tableau.

Position et taille
Impress  traite  les  tableaux  comme  n’importe  quel  objet  graphique.  Vous  pouvez  déplacer  et
redimensionner le tableau sur la diapositive avec la souris, ou pour plus de précision par la boîte
de dialogue Position et taille (Figure 32). Lorsque le tableau est sélectionné, cliquez-droit sur sa
bordure et choisissez Position et taille dans le menu déroulant ou utilisez Format > Position et
taille dans la barre de menu. Seul l’onglet  Position et taille est opérationnel pour les tableaux.
Pour plus d’informations, voyez le Chapitre 6, Mettre en forme des objets graphiques.

Note
Contrairement aux autres objets graphiques, on ne peut pas faire pivoter les 
tableaux.
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Figure 32 : Boîte de dialogue Position et taille

Supprimer un tableau
Pour détruire un tableau, utilisez une des méthodes suivantes :

• cliquez dans la diapositive et tirez pour sélectionner le tableau puis pressez la touche
Suppr ;

• sélectionnez toutes les lignes du tableau et cliquez sur l’icône Supprimer la ligne de la
barre d’outils Tableau (Figure 29) ou procédez de la même façon avec les colonnes.

Utiliser les champs

Les  champs  permettent  l’insertion  automatique  de  texte  dans  la  diapositive.  Vous  pouvez
considérer un champ comme une sorte de formule qui est calculée lorsque le document est chargé
ou imprimé et dont le résultat est intégré au document. Les champs sont communément utilisés
lors de la création de modèles et de masques de diapositives comme expliqué dans le Chapitre 2
Utiliser des pages maîtresses, styles et modèles.

Insérer un champ
Pour insérer un champ dans une diapositive, placez le curseur sur le point d’insertion et choisissez
Insertion > Champs dans la barre de menu avec l’un des types ci-dessous.

• Date (fixe) : insère la date au jour de l’insertion du champ.

• Date (variable) : insère un champ qui est mis à jour avec la date lors de l’ouverture du
fichier.

• Heure (fixe) : insère l’heure au moment de l’insertion du champ.

• Heure (variable) : insère un champ qui est mis à jour avec l’heure lors de l’ouverture du
fichier.

• Auteur :  insère le  nom de l’auteur  de la  présentation.  Le contenu de ce champ est
alimenté  par  les  valeurs  enregistrées dans les  options  générales.  Pour  modifier  ces
informations allez à Outils > Options > LibreOffice > Données d’identité.

• Numéro de page : insère le numéro de la diapositive.

• Nombre de pages : insère le nombre total de diapositives.

• Nom de fichier : insère un champ contenant le nom du fichier.
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Personnaliser les champs
L’aspect de chaque champ, y compris le champ  Numéro de page peut être personnalisé avec
l’éditeur de champs correspondant. Pour ouvrir l’Éditeur de champ (Figure 33) :

1) sélectionnez le champ ;

2) choisissez Édition > Champs dans la barre de menu ou cliquez-droit sur le champ ;

3) sélectionnez le format désiré dans la boîte de dialogue qui s’affiche ;

4) cliquez sur OK.

Figure 33 : Boîte de dialogue Éditer le champ

Utiliser les hyperliens

Lorsqu’on insère un texte (tel que adresse de site web ou URL) qui peut être reconnu par Impress
comme un hyperlien, il est formaté automatiquement (l’hyperlien est créé avec la couleur et le
soulignage prédéfinis). Si vous voulez éviter cela, sélectionnez Édition > Annuler depuis la barre
de menu ou pressez Ctrl+z immédiatement après le formatage automatique.

Vous pouvez aussi insérer manuellement des hyperliens.

Astuce

Pour empêcher LibreOffice de transformer automatiquement les adresses de site 
web (URL), en hyperliens, allez à Outils > Options d’autocorrection > Options et 
décochez la case Détecter les URL.
Pour modifier la couleur des hyperliens, allez à Outils > Options > LibreOffice > 
Apparence, et faites défiler jusqu’à Liens non visités ou Liens visités, sélectionnez 
les cases à cocher, prenez la nouvelle couleur et cliquez sur OK. Attention, cela 
change la couleur de tous les hyperliens dans l’ensemble des composants de 
LibreOffice, ce qui n’est peut-être pas ce que vous attendez.

Pour insérer un hyperlien ou pour personnaliser l’aspect d’un hyperlien, sélectionnez Insertion >
Hyperlien dans la barre de menu. La boîte de dialogue Hyperlien s’ouvre (Figure 34).
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Sur le côté gauche, sélectionnez l’un des quatre types d’hyperlien. Le haut de la partie droite
change en fonction du choix. Ce chapitre n’a pas pour objectif la description détaillée de tous les
choix possibles et  de leurs interactions.  Un résumé des choix les plus courants est donné ci-
dessous.

Figure 34 : Boîte de dialogue Hyperlien

• Internet : choisissez le type de lien (Internet, FTP ou Telnet). Saisissez l’adresse web
(URL).

• Mail  &  News :  choisissez  le  type  de  lien  (E-mail  ou  News).  Saisissez  l’adresse  du
destinataire et, pour le type E-mail, l’objet du message.

• Document : créez un lien (marque-page) vers un autre document ou un autre endroit de
la  présentation.  Saisissez  le  chemin  d’accès  au  document  ou  cliquez  sur  l’icône
d’ouverture de fichier pour ouvrir un navigateur de fichiers ; laissez cette zone en blanc si
la  cible  appartient  à  la  même présentation.  Cliquez  sur  l’icône  Cible  pour  ouvrir  le
navigateur avec lequel vous pourrez choisir la cible, ou, si vous connaissez son nom,
vous pouvez le saisir directement dans la boîte.

• Nouveau document :  créez un lien  vers un nouveau document.  Choisissez si  vous
voulez  renseigner  immédiatement  le  nouveau  document  (Éditer  maintenant)  ou
seulement créer le fichier (Éditer plus tard). Choisissez le type de document à créer
(Texte,  Classeur,  etc.).   Le  bouton  Sélectionner  un  chemin ouvre  un  navigateur  de
fichiers qui vous permet d’indiquer le dossier où sera déposé le document.

Note
Pour naviguer à l’intérieur d’une même présentation, il est préférable d’utiliser le 
menu Interaction ouvert depuis l’icône Interaction  de la barre d’outils Dessin ou 
dans le menu contextuel affiché lors d’un clic-droit sur un objet.

Les  autres  paramètres  de  la  boîte  de  dialogue  Hyperlien sont  communs  à  tous  les  types
d’hyperliens, bien que certains choix soient plus pertinents pour certains types de liens.

• Cadre : Choisissez une valeur dans la liste pour imposer la manière dont l’hyperlien va
s’ouvrir. S’applique aux documents qui s’ouvrent à l’aide d’un navigateur web.

• Formulaire : Voulez-vous présenter le lien comme un texte ou comme un bouton ? Voir
Travailler avec les boutons d’hyperlien, page 36 pour plus d’informations.

• Texte : Saisissez le texte qui sera présenté à l’utilisateur.
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• Nom : Si le lien s’adresse à un document HTML, saisissez ici un texte qui sera intégré
comme balise  NAME dans le  code HTML,  derrière  l’hyperlien.  Non fonctionnel  dans
Impress.

Éditer le texte des hyperliens
Pour éditer un texte d’hyperlien, sélectionnez-le (en glissant autour et non en cliquant dessus),
puis choisissez Édition > Hyperlien dans la barre de menu. Faites les modifications voulues et
cliquez sur Appliquer. Si vous avez plusieurs hyperliens à modifier, vous pouvez laisser la boîte
de  dialogue  ouverte  jusqu’à  ce  que  vous  ayez  terminé.  Assurez-vous  de  bien  cliquer  sur
Appliquer après chaque lien, puis cliquez sur Fermer.

Travailler avec les boutons d’hyperlien
Un bouton hyperlien sera inséré au centre de la diapositive, dans la plupart des cas, vous devrez
le déplacer. Pour éditer le texte, la taille d’un bouton hyperlien ou pour le déplacer, affichez d’abord
la barre d’outils Contrôles de formulaire (Affichage > Barres d’outils > Contrôles de formulaire)
(Figure 35). Cliquez sur l’icône Mode ébauche  (en surbrillance) pour l’activer.

Figure 35 : Barre d’outils Contrôles de formulaire

Maintenant vous pouvez sélectionner le bouton d’hyperlien et le faire glisser vers un autre endroit
ou cliquer-droit pour en modifier le texte, la taille, et d’autres propriétés.

Lorsque vous avez terminé, cliquez à nouveau sur l’icône Mode ébauche  pour la désactiver.
Pour une description détaillée des propriétés des Contrôles de formulaire, et apprendre comment
les utiliser,  référez-vous au guide  LibreOffice Writer,  Chapitre 15  Utiliser  des formulaires dans
Writer.
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